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Trademarks 

Microsoft is a U.S. registered trademark of Microsoft 
Corporation. 
Windows and MS-DOS are trademarks of Microsoft Corporation. 
IBM, IBM PC are registered trademarks of International Business 
Machines Corp. 
ENERGY STAR® is a U.S. registered mark. 
Other brands and product names herein are trademarks or 
registered trademarks of their respective holders. 

Copyright 

All rights reserved. No part of this publication may be 
reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language or computer language, 
in any form or by any means, electronic, mechanical, magnetic, 
optical, chemical, manual, or otherwise, without the prior 
written permission of Avision Inc. 
 
Material scanned by this product may be protected by 
governmental laws and other regulations, such as copyright 
laws, the customer is solely responsible for complying with all 
such laws and regulations. 

 

Warranty 

The information contained in this document is subject to 
change without notice. 
 
Avision makes no warranty of any kind with regard to this 
material, including, but not limited to, the implied warranties 
of fitness for a particular purpose. 
 
Avision shall not be liable for errors contained herein or for 
incidental or consequential damages in connection with the 
furnishing, performance, or use of this material.  
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Federal Communications Commission (FCC) compliance 
information statement 
Part 15 
 
The product has been tested and found to comply with the 
limits for a Class A digital device pursuant to Part 15 of the FCC 
Rules.  Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference and (2) this 
device must accept any interference received including 
interference that may cause undesired operation. 
 
The FCC Class A limits are designed to provide reasonable 
protection against harmful interference when the equipment is 
operated in a commercial environment.  This equipment 
generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instruction 
manual may cause harmful interference in which case the user 
will be required to correct the interference at his own expense. 

  
 
CE 
 
Warning 

This is a class A product. In a domestic environment this 
product may cause radio interference in which case the user 
may be required to take adequate measures. 
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Disposal of Waste Equipment  

 

This symbol on the product or on its packaging indicates that 
the product can not be disposed of with your other household 
waste.  Instead it should be sent to appropriate facilities for 
recovery and recycling in an effort to protect human health and 
the environment.  For more information about where you can 
drop off your waste equipment for recycling, please contact 
your local city office, your household waste disposal service or 
the shop where you purchased the product.   
 
 

 

As an ENERGY STAR® Partner, Avision Inc. has 
determined that this product meets the ENERGY 
STAR guidelines for energy efficiency. 

 
 
 
System Requirements 
 

• IBM compatible PC 586, Pentium or higher 

• Microsoft Windows 2000/XP 

• High speed USB 2.0 port (compatible with USB 1.1) 

• 100M bytes of available hard disk space for installation; 

• 128M bytes of RAM 

• A CD-ROM drive 
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1. Introduction 
 

Congratulations on your purchase of the document 
scanner. 

Before you install and operate the scanner, please take a 
few minutes to read through this manual. It provides 
you with the proper instructions on how to unpack, 
install, operate and maintain the scanner. 

Figure 1-1 shows how the scanner is packed.  You can 
check all items against your “checklist”, included with 
your scanner. 

 

3 

4 
1 

5

1.   Scanner main unit 
2.   Power adapter 
3.   Power cord 
4.   USB cable 
5.   User’s manual/CD 

 
Figure 1-1 Scanner Packaging 

Note:  When you unpack the scanner, retain the packing 
material and shipping box in case you may transport the 
scanner in the future. 
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2. Installation 
 
 
Please unpack the scanner carefully, and check the 
contents against the checklist.  If any items are missing or 
damaged, please contact your authorized local dealer 
immediately. 

Precautions 

• Keep the scanner out of direct sunlight.  Direct 
exposure to the sun or excessive heat may cause 
damage to the unit. 

• Do not install the scanner in a humid or dusty place. 

• Use only the AC adapter ((HEG42-240200-7L by HITRON 
/ DA-48M24 by ADP)) included with the machine. Using 
other AC adapters may damage the machine and 
void the warranty. 

• Place the scanner securely on an even, flat surface. 
Tilted or uneven surfaces may cause mechanical or 
paper-feeding problems. 

• Retain the scanner box and packing materials for 
shipping purposes. 

2.1 Unlocking the Shipping switch 

The scanner has a shipping switch that locks the carrier 
mechanism for transportation purposes.  This switch must 
be unlocked before using the scanner. 

Before proceeding, turn the power off, disconnect all cables 
and follow the instructions below to unlock the shipping 
switch. 
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2.1.1 Unlocking the scanner 

 
1. Carefully place the scanner in an upright position on its 

front. 

2. Unlock the scanner by moving the lock switch beneath 
the scanner to the “Unlock” position (See Figure 2-1). 

3. Gently place the scanner back to its normal position. 
 
 
 
 

  
 

Figure 2-1  Unlock the Shipping Switch
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2.1.2 Locking the Shipping switch 

 

 
Whenever you need to move the scanner to a new location 
it is advisable to lock the shipping switch to avoid causing 
damage to the scanners’ internal mechanism. Please follow 
the instructions below to lock the shipping switch. 

 

1). Turn off the scanner. 

2). Lift the Document cover to reveal the flatbed glass and 

scanning unit. 

3). Turn on the scanner. 

4). Turn off the scanner again while the scanning unit 

moved to the end for a few seconds. 

5). Place your scanner in an upright position on its front 

side. 

6). Lock your scanner by moving the lock switch to the 

"Locked position".  

7). Place the scanner back to its normal position.   
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2.2 ADF Paper Chute 

1. Lift the paper chute to about 45 degrees.  

2. Pull the paper-chute wire leg down to the grips on the 

document cover. 

3. Slightly press the paper chute to snap the wire leg into 

the grips on the document cover. 

4. Pull out the paper chute extension to the length you 

want. 

 

Paper Chute 
Extension 

 

 

ADF Paper Chute 

Paper Chute 
Wire Legs  

Figure 2-3 Install the ADF Unit 
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2.3 ADF Output Tray  

 
1. Hold the output paper tray some 30 degrees aslant as 

shown in Figure 2-4. 

2. Insert the three protrusions on the output paper tray 
to the three slots on the ADF. 

3. Release the paper tray gently. Make sure the tray is 
firmly attached to the ADF.  

4. Pull out the output paper tray extension wire to the 
desired length. 

 

 

    

Output Tray 
Extension Wire 

 

Figure 2-4 Install the ADF Output Paper Tray 
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2.4 Connecting the Cables 

Make sure the power of scanner is off. 

2.4.1 Connecting to Power 

Plug the small end of the power adaptor into the power jack 
of your scanner.  Insert the other end to an appropriate 
power outlet. 

       
 

 
 

Power Cable 

2.5 Installing the Software 

Note:  
1). The Windows system CD may be required when 

installing on some PC’s. 
2). To ensure your computer can identify the USB scanner, 

please install scanner driver first before connecting the 
scanner to your computer. 

 
1. Place the supplied CD-ROM onto your CD-ROM drive. 

2. The software installation graphic appears.  If not, run 
“setup.exe”. 
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3. Choose Install Scanner Driver to install the scanner 
driver. 

 
 

2.6 Connecting to Computer 

 
1. Connect the square end of the USB cable to the USB port 

of your scanner.   Connect the rectangle end to the USB 
port of your computer.  

        
USB Cable  
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2. The computer should detect a new USB device and 

prompt a “New Hardware Found” message. 

 

 

             
3. In Windows XP, click the Next button to continue. 

When the XP certification screen appears, click 
Continue Anyway to complete the installation. 

       
4. When the Finish dialog is prompted, click the Finish 

button.  

5. Click “View Manual” to view or print the detailed user 
manual for the scanner and bundled applications 
respectively. 

 

Note:  To uninstall the scanner driver in Windows XP, be 
sure to keep your scanner connecting to your computer.  
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3. Completing Your First 
Scan 

 
 

3.1 ocument Loading D

 

For flatbed scanning 

 
Documents that can not be scanned using the ADF can be 
placed on the flatbed for scanning.  (See Figure 3-1) 

 
1. Place the document to be scanned onto the document 

glass face down. 

2. Position the document so that the upper-right corner is 
aligned with the reference mark. 

 
 

Figure 3-1  Place Document on the scanner 
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3.2 ADF Scanning 

 
 
Multiple documents can be fed automatically using the ADF.  
Refer to Figure 3-2. 

 

1. To prevent occasional paper jam when automatically 
feeding multiple documents, fan the paper before loading. 

2. Lift the balance wire. 
3. Place the documents onto the ADF paper chute in either 

paper side (face-down, face-up), with the leading edge in 
the auto feeder entrance.   

     Let the balance wire rest on the top of the documents. 

4. Adjust the left and right guides so that they are snug 
against the sides of the documents. 

 

 

 

Balance Wire 

Paper 
Guide 

 

Figure 3-2  Load Multiple Document 
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3.3 erifying Your Scanner Installation   V

To verify if your scanner installation is correct, Avision provides 
you a useful test program called Avision Capture Tool.  With 
this tool, you can perform simple scans and view the captured 
images.  In addition, it helps you complete your scan at a rated 
speed. 
 
The following procedure describes how to verify your scanner 
installation.  If the installation is not correct, please review the 
preceding section to check if the cable connection and scanner 
driver have been successfully installed.    
 
Before you begin, be sure the scanner is on. 
 
1. Select Start>Programs>Avision AVxxx Scanner>Avision 

Capture Tool. 
The Select Scanner Model dialog box will be displayed.  

 
 

2. Select your driver type and scanner model and click OK.  
The following Avision Capture Tool dialog box will be 
displayed. 
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Fit 
Page 

Actual  
Size

 
 

 

Save       File Path 
File Format 

 
 
Setup    

Scan 
 

3. Choose your desired file format from the File Format drop 
down list box. (Default is BMP, other choice includes TIFF, 
GIF, and JPEG.) 

4. Type your desired folder name and file name in the File 
Path box. (Default is C:\My Scan\Image.) 

Note: If you do not wish to save the scanned image, 
deselect the Save button since default is Save Enable. In 
this case, the thumbnail view will be disabled.  And 
therefore, after viewing all the scanned images, only the 
last one will remain on the screen.   

5. Click the Setup button ( ) or choose Setup from the 
File menu to prompt the Scanner Properties dialog box. 
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Image 
Selection 

Box 

 
 
6. From the Image Selection Box, choose your desired image 

type for your scanned image.  (Default is Front B&W)  If 
you have a duplex scanner, choose Front and Rear to scan 
both sides of your document.  

7. Click OK to quit the Scanner Properties dialog box.  (To 
learn more details about the Scanner Properties dialog box, 
please see the subsequent chapter, Using the Scanner 
Properties Dialog Box.) 

8. Place your document face down on the document glass or 
face up in the auto document feeder. 

9. In the Scan Validation dialog box, click the Scan button 

( ) or choose Scan from the File menu. 

10. The document will be scanned and displayed in the Scan 
Validation screen.  After the scanned images have been 
displayed, your scanner installation verification is 
completed.  
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Status Bar  Fit Page View 

 Thumbnail View 
 

11. You can view the scanned image in Fit Page ( ) or 

Actual Size (100%) button ( ) from the Viewing toolbars 
at the right side. 

12. Click the Close box or Quit from the File menu to exit the 
Scan Validation Tool. 
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3.3.1 A Glance of the Scanner Properties Dialog Box 
 

 

1 

 

2 3 
4 
5 
6 
 
7 

8 

 
1. Tab Options Choice:  Image, Compression, Color Dropout, 

Paper, Options, Settings, Information. 
2. Image 

Selection Box  
Choose your image type and the side of 
document you wish to scan.  Options vary 
based on type of scanner.  

3. Brightness: Adjust the brightness level from –100 to +100.   
4. Contrast Adjust the contrast level from –100 to +100. 

Determine the quality of the scanned image.  
The industry standard is 200 dpi. 

5. Resolution 

6. Invert Reverse the color of your scanned image. 
7. Scan Source  Choice: Auto Document Feeder, Flatbed, 

Flatbed (Book), Automatic (varies due to 
different scanner model)  

8. Defaults Reset all values on the tabs to the factory 
default settings. 
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4. Using the Scanner 
erties Dialog Box  Prop

 
 
 
The Scanner Properties dialog box allows you to configure the 
scanner’s settings. It consists of several tabbed windows each 
of which will be described in this chapter. 
 

 
 

The Scanner Properties dialog box 

 4-1



 
 

4.1 Buttons on the Scanner Properties Dialog Box  

 

The buttons on the Scanner Properties dialog box 
 

Buttons Description 

Defaults Click the Defaults button, the factory default 
settings will be shown on each tab.   

Scan After all the scan settings are satisfactory, click 
the Scan button to start scanning your 
document. 

Close Click the Close button to leave the Scanner 
Properties dialog box. 
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The following table shows the default settings： 
 
Tab name Default settings 
Image Image：Front B&W 

Binarization：Dynamic Threshold 
Resolution：200 dpi 
Invert：Blank on White 
Scan Source：Auto Document Feeder 
Threshold：None 
Brightness：None 
Contrast：None 

Compression None 

Color Dropout None 

Paper Cropping：Automatic 
Deskew：Yes 
Orientation：Portrait 
OverScan：0.00  
Multifeed Detection：None 
Unit：Inch 

Options Rotation Degrees：None 
Blank Page Removal：None 
Edge Fill：White，0 mm 
Image Control Option：None 

Setting Enable Energy Saver：Enable, 15 
minutes after last scan action 
Show Scanning Progress：Yes 
Show Warning Message：Yes 
Save Settings after Closing：Yes 
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4.2 The Image Tab  

The Image tab allows you to choose the front side and (or) the 
rear side of your document, the type of image, and to set 
several basic scan settings.  Note that except for the resolution, 
you can set individual scan settings for the front side and the 
rear side.  For example, all settings in the Image tab, 
Compression tab, Color Dropout tab can be set individually for 
the front and the rear side.  However, the settings in the Paper 
tab, the Option tab, and the Setting tab have to be set the 
same for the front and rear side.   
 

 
 

The Image tab dialog box 
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4.2.1 The Image Selection Box 

 

The Image Selection box includes 
the image type and document side 
option.  If you wish to scan both the 
front side and the rear side of your 
color document, you can check both 
Front Color and Rear Color at the 
same time.  Note the options vary 
based on type of scanner. 

 
Example 1：Scanning a two-sided color document, both 
sides in color 

 

Side/Image 
Selection 

 
Front  

Rear 
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Example 2：Scanning a two-sided color document, one 
in B&W(Drop Blue Color：Threshold：10, Background：
79), the other in color 

 

 

Side/Image 
Selection 

 

Front 

 

Rear 

 

Image Type Description 
Color Choose Color if you wish to scan a color 

image for your original in color.  
Gray Choose Gray image if your original contains 

actual shades of gray. 
B&W Choose B&W if your original contains only text

pencil or ink sketch. 

   
B&W Gray Color 

 4-6



User’s Manual 
 
 

Front/Rear Auto Color Detection:  
Click to automatically detect and scan the front or the rear 
page of your color document in color image mode.  If your 
document is in colors, the scanner will automatically scan the 
document into a color image.  If your document is non-color, 
you can choose the output to be either B&W or Gray from 
the Non-Color Selection option.  This option is useful when 
you have a mixture of color and non-color document. 

Note:  If you choose Front Rear Auto Color Detection, you 
can not specify the image mode of your rear page and vice 
versas. 
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4.2.2 Other Image Options 

Binarization This is the process of converting a 
grayscale or color image to a bi-tonal 
image. There are several different 
methods of performing this conversion.  
Options:  Dynamic Threshold, Fixed 
Processing, Halftone 1~5, Error 
Diffusion. 
 

Dynamic Threshold:  Selecting 
Dynamic Threshold allows the scanner 
to dynamically evaluate each document 
to determine the optimal threshold value 
to produce the highest quality image.  
This is used to scan mixed document 
containing faint text, shaded background, 
or color background with a single setting.  
If Dynamic Threshold is selected, 
Threshold, Brightness, and Contrast are 
not available. 
 
Fixed Processing:  Used for black-and-
white and other high contrast documents.  
A single level is set to determine the 
black-and-white transition. The threshold 
is programmable over the entire density 
range.  Fixed Processing sets Contrast 
to 0.  If Fixed Processing is selected, 
Contrast is not available. 
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 Halftone:  In addition to the black and 

white display, Halftone can present a 
somehow gray shade of image by using 
different size of dots.  Halftone image looks 
like the picture we have seen in the 
newspaper.  Options include Halftone 1, 
Halftone 2, Halftone 3, Halftone 4, 
Halftone 5.  
 
Error Diffusion:  Error Diffusion is a type 
of Halftone.  Error Diffusion gives good 
image texture and makes text in images 
more readable than Halftone. 
 

 
Halftone Image 

 

 
Error Diffusion Image 
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Threshold Used to convert a grayscale image to a  

bi-tonal image. The value ranges from 0 to 
255. A low threshold value produces a 
lighter image, and can be used to subdue 

 th es 

Threshold sliding bar to the left or right to 
red threshol

 

backgrounds and subtle, unneeded 
information. A high

up faint images.  
Adjust the threshold se

achieve the desi

reshold value produc
a darker image, and can be used to help pick 

tting by dragging the 

d setting. 

 
 
200 dpi, 
Threshold:80, 
Brightness: 0 

 
 
200 dpi,  
Threshold:170, 
Brightness: 0 
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Gray  

ocument Type:  Choice:  Normal, Photo, Document   
s o hoose 

Gray as the im :  
Normal, Photo,

• Documen ns 
pure text 
optimal se
using Doc

• Photo: C
reproduce
using Pho ed. 

• Normal: ness, and 
Contrast can be adjusted.  

 
Threshold:  The value ranges from 0 to 255.  The default is 
230.  A low threshold value produces a lighter image, and can 
be used to subdue backgrounds and subtle, unneeded 
information. A high threshold value produces a darker image, 
and can be used to help pick up faint images. Adjust the 
threshold setting by dragging the Threshold sliding bar to the 
left or right to achieve the desired threshold setting. 

D
Three option f document type are provided when you c

age type for your scanned document.  Choice
 Document.  

t: Choose Document if your original contai
or a mixture of text and graphic since it is an 
tting for regular business document.  When 
ument, only Threshold can be adjusted.   
hoose Photo if your original contains photo to 
 your photo in vivid grayscale image.  When 
to, no Threshold and Contrast can be adjust

hen using Normal, Threshold, BrightW
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Normal 

 
Photo Document 

(Threshold: 230) 
 

  
Normal 

 
Photo Document 

(Threshold: 230) 
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Brightness Adjusts the lightness or darkness of an 
image.  The higher the value, the brighter 
the image.  Drag the slider to the right or 
left to increase or decrease the brightness.  
The range is from –100 to +100. 

Contrast Adjusts the range between the darkest and 
the lightest shades in the image.  The 
higher the contrast, the bigger the different 
grayscale. Drag the slider to the right or 
left to increase or decrease the contrast.  
The range is from –100 to +100.
 

 

   
Brightness: -50 Brightness: 0 

(Normal) 
Brightness: +50 

   
Contrast: -50 Contrast: 0 

(Normal) 
Contrast: +50 
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R A

g
r
(
t
s
m
t
a
T ximately 25 
MB of disk space. A higher resolution 
(usually means over 600 dpi) is only 
recommended when you need to scan a 
small area at True Color mode.  

Choose a resolution value from the drop 
down list. The default value is 200 dpi. 
Available resolutions are 75, 100, 150, 
200,300, 400 and 600. Or you may choose 
your desired value by clicking the box in the 
right side of the drop down list and press the 

ro your d
then dd button to include it in the 
drop down list. 

esolution  good control of the resolution results a 
ood detail of an image that scans.  The 
esolution is measured by dots per inch 
dpi).  Normally, the greater the dpi number, 
he higher the resolution and the image file 
ize.  Be aware that greater resolution takes 
ore time to scan, and more disk space for 

he scanning image.  For your information, 
n A4 size color image scanned at 300 dpi at 
rue Color mode consumes appro

ar w key to select 
 click the A

esired value and 

  
on: 150 dpi Resolution: 75 dpi Resoluti
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Invert Revers

image

backgr
change
comm
 

es the brightness and the colors in the 
.  The default setting is Black on a White 

ound. For color images, each pixel will be 
d into its complementary color at the 

and of Invert. 

background.  Reverse mode is White on a Black 

 
Black on White 

 

 

White on Black  
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Scan 
Source 

Choice: 
 

):  Used to scan several 
inside pages from book. 

 Automatic:  Allow the scanner automatically 
set its scan source.  If Automatic is selected 
and there is document in both the auto 

omatically set to 
ADF.  If Automatic is selected and there is 
docum d, th n the scan 
source w bed. 

 Merge Two Sides into One Image:  
If you have a sheet-fed duplex scanner with 
front input tray, you can scan an A3 size 
document with an innovative method.  Thus, 
fold your A3 size document into A4, and then 
load the paper in the front tray.  Choose 
Merge Two Sides from the Scan Source 
option and then the scanner is able to scan 
both sides of your document and merge two 
A4 images into one A3 image.  

 
When you select Merge Two Sides into One 
Image, the Cropping or Multi-feed function 
will be disabled. 

 
Note the options vary based on type of 
scanner. 
 

 
 
 
 

 Auto Document Feeder:  Used to scan
multiple pages. 

 Flatbed:  Used to scan a single page. For 
example, pages from newspaper clipping, 
paper with wrinkles or curls.  

 Flatbed (book

document feeder (ADF) and the flatbed, then 
the scan source will be aut

ent only in flatbe
ill be set to flat

e
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Color 
Adjustment 

Adjusts the color quality of the image so 
that it comes close to that of the original.  

 function uses default parameters to  This
adjust the image. 

 
Normal 

 

 
After Color Adjustment 

 color images 

 

4.2.3 Scanning

The following op .  

 Bri
 
 
 

tions are available for scanning color images

ghtness 
Contrast 
Resolution 
Invert 
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4.2.4 Scanning grayscale images  

The following options are available for scanning gray images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

  

4.2.5 Scanning B&W images  

The following options are available for scanning B&W images.  

 Binarization (Dynamic Threshold) 
 Resolution 
 Invert 
 

Or 
 Binarization (Fix Processing) 
 Threshold 
 Brightness 
 Resolution 
 Invert 
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4.2.6 Editing Profiles 

The Scanner Properties dialog box allows you to change and 
 

edit these profiles by renaming or deleting them.  
 
T  d
 

 Customize your settings.  (For example, change your 
resolution, image type, cropping method, scan size, or 
other scan settings.)  

the “Edit Your Profile” dialog box.  

 

save your frequently used scan settings into a profile.  You can

o a d a new profile, 

1.

2. Click the Image tab and then choose “Profiles” to prompt 

 
 
3. Click “Add” to enter the name of the profile and then 

choose “Save”. 

 
 
4. The new profile will be saved and shown in the “Profiles” 

dropdown list box.  
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To load a profile,  
 
 
1. From the Image tab dialog box, choose your favorable 

profile from the “Profiles” dropdown list box. 

 

Your favorable profile will be imme2. diately loaded and 
displayed on Scanner Properties dialog box. 

 
 
To delete a profile, 
 
1. From the Image tab dialog box, click “Profiles” to prompt 

the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to delete from the dropdown 

list box. 
3. Click “Delete”.  A Confirm message “Are you sure you 

want to delete this profile?” is prompted. 
4. Choose “Yes” to delete or “Cancel” to quit. 
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To rename a profile, 

t 

 
 
1. From the Image tab dialog box, click “Profiles” to promp

the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to rename from the dropd

list box and then click the Rename button. 
own 

or the profile. 
 
3. Enter new name f

 
 

 Choose “Save” to save the new profile or “Cancel” to quit. 4.
 
Note: 
The preset default profiles include Flatbed, Simplex-B&W, 200 
dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-
B& oW, 200 dpi, Duplex-Gray, 200 dpi, Duplex-C lor, 200 dpi.  If 
you have a simplex or a sheetfed scanner, the duplex or the 
flatbed option will not be available. 
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4.3 The Compression Tab 

imag ssion.  Bi-tonal images 
are normally compressed using CCITT standard called Group 4 
(G4).  Color and grayscale images are often compressed using 
JPEG technology.  Move the JPEG Quality slider to the right or 
left to increase or decrease the level of compression.  Note the 
greater the compression level, the lower image quality.  Default 
is 50%. 

 

appl es not support 
e type of compression format, then  either a warning 

y of the compressed file 
will not be acceptable.  
 
JPEG (Joint Photographic Editor Group).  This group developed 
and lent their name to a file compression standard for color and 
grayscale images that is widely used by scanners, and software 
applications.  On Microsoft Windows-based systems, a file with 
the extension .jpg has normally been compressed using this 
standard. 

 

re available: 
 None 

 G4 
 

 
 

The Compression tab allows you to compress your scanned 
e and choose the level of compre

Note that the compression depends on your image editing 
ication.  If your image editing application do

th
message will appear or the image qualit

For scanning color or gray images, the following compressions 
a

 JPEG 
 
For scanning B&W images, the following compressions are 
available: 

 None  
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The Compression tab dialog box 



 

 

4.4 The Color Dropout Tab   

4.4.1 Color Dropout Selection 

Color Dropout tab allows you to drop either of the red, blue, or 
green color in your scanned image.  If your image contains red 
color watermark or background, choose the R (Red) channel 
then any red watermark or background will be removed.  This 
feature is used to sharpen your text when using OCR (Optical 
Character Recognition) software.   

Note that this function supports only black & white and gray 
images.  Therefore, be sure to choose any black & white or 
gray image type while applying this function. 
 

 
 

The Color Dropout dialog box 
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4.4.2 Other Color Dropout Options 

o options that can adjust 
your scanned image in the best optimal result. 

Filter Threshold and Background Level to 
produce the best optimal result. 
 

Example, slightly adjusting the background value makes 
your text more clear.  
 

 
Advanced Processing provides tw

 
Filter 
Threshold 

This value is used to determine the color 
which will be dropped out.  A lower value will 
drop more of the selected color out, while a 
higher value will leave more of the selected 
color in. 

Background 
Level 

The pixel which is higher than the 
background value will be adjusted to the 
lightest point.  Adjust the value for both the 

 
Original 
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ove Blue, Threshold: 20, Background: 

 
Rem
255

 
Remove Blue, Threshold: 20,  
Background Level: 210 
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4.5 The Paper Tab  

The Paper tab allows you to define values relating to image 
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed 
Detection).  
 

 

The Paper tab dialog box 
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4.5.1 Cropping  

Cropping allows you to capture a portion of the document 
being scanned.  Choice:  Automatic, Fixed to 
Transport, EOP (End of Page) Detection. 

 
Options Description 

Automatic Automatic adjusts the cropping window 
according to different document sizes. Use 
this option for batches of mixed-sized 
documents. 

Fixed to 
Transport 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-sized documents.  If you select this 
option, you can use the arrow keys to 
define the x and y offset values, width and 
length to redefine your scanned area.  The 
Display window will show image placement 
as you change the values. 

EOP (End of This feature allows you to define the area 
Page) or zone to be imaged.  Use for batches of 
Detection same-width but different length 

documents.  If you select this option, you 
can use the arrow keys to define the x and 
y th to  offset values, width and leng
redefine your scanned area.  The Display 
window will sh  image placement as you ow
change the values. 
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The following options are only available when Fixed to 

 of the 
scanner to the left edge of the scanning area.  

et — om the top end of the 
t to

 Width — th

 Length — t

r: aut -
ng 

 

Transport is selected.  

 
 X-Offset — the distance from the left end

 Y-Offs  the position fr
documen  the top end of the scanning area.  

e width of the scanning area.  

he length of the scanning area.  

 Cente
fed feedi

omatically calculates the x-offset for center
based upon document size selected. 

— relocate the scan area by click the arrow key on 
the cross sig t 
from the Dis

n while retain the scan size.  View the resul
play window.   
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Example： Redefine your scan area ( x-offset: 2.25 inches；y-
 

offset:1.13 inches) 
 

Scan 
Area 

Display  
window 

 
 

 
Original 

 

After Fixed to 
Transport 

 
 

The Redefined Scan Area 
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 Selection 

eskew 

Use this option to automatically deskew a document.   

 

4.5.2 Other Paper

D

  
 
 
Scan Area  

Choose your desired paper size with the drop-down list box.  Or 
you may select a custom paper size by clicking the Scan Area 
ox and then click Add to include in the choice. 

Choice:  None, US Letter- 8.5”x 11”, US Legal – 8.5” x 14”, 
ISO A4 – 21 x 29.7 cm, ISO A5 – 14.8 x 21 cm, ISO A6 – 10.5 
x 14.8cm, ISO A7 – 7.4 x 10/5 cm, ISO B5 – 17.6 x 25 cm, 
ISO B6 – 12.5 x 17.6 cm, ISO B7 – 8.8 x 12.5 cm, JIS B5 – 
18.2 x 25.7 cm, JIS B6 – 12.8 x 18.2 cm, JIS B7 – 9.1 x 12.8 
cm, Scanner Maximum, Long Page. 

 
Long Page:   
When you need to scan documents whose length exceeds 
scanner maximum, please choose Long Page.  Note if Long 
Page is selected, the Multi-Feed Detection will not be a  
Options: Un gth, ter Lengt ption 
varies due to type of scanner.)   

Note: If the skew angle is 
too great, some of the 
image may be cut off. 

b

vailable.
known Len En h   (Note: This o
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Choose “Unknown Length” if you have a batch of long page 

Choose “Enter Length” to 
enter the length and width of your documents or your desired 

on documents.  This is useful when you have a batch 
of documents with the same scan size or a batch of same-sized 

OverScan 
Overscan allows you to add a s ttom 
or right and left (Options vary based on the type of scanner) of 
the edge of the image.  This is used to reduce possible corner 
clipping on the skewed images and often applied to a batch of 
skewed document to be scanned in the auto document feeder.  

sult will not be shown in the Display window and that the 
 the function varies based on type of scanner.  

ped document 
y 

of 

on allows you to define the length of 
al 

t used when scanning same-
ize documents in the auto document feeder.   

document with unknown length. 

scan size 

documents. 

pecific margin at top and bo

Select a value between 0 and +5 mm.   Note the overscan 
re
availability of
 
 
Multi-Feed Detection    

Multi-Feed Detection allows you to detect overlap
that go through the auto document feeder.  Multi-Feed usuall
occurs due to stapled documents, adhesives on documents, or 
electro-statically charged document.  Note： The availability 
the function varies based on type of scanner. 

Additional Length Detection 

Additional Length Detecti
document being multi-fed.  This value indicates the addition
length exceeding your scan area.  The Display window will 
show the size of the document as you change the value.  A 
value of 0 indicates no additional length detection.  The 
Additional Length Detection is bes
s
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Example：Additional Length Detection：Set Additiona
Length to be 2.02 inches 
 

l 

2.02” 
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Ultrasonic Detection 

ou to set overlapped document by 
etecting paper thickness between documents.  Note： The 

availability of the function varies based on type of scanner. 
 
 
There are two options available if Multi-Feed is detected.  

 Stop Scanning after Multi-Feed 

If this is selected, the scanner will stop the feeder and 
display the following Warning dialog box if multi-feed is 
detected. 

 
Ultrasonic Detection  allows y
d

 

 

Action:   

1. Follow the instruction on the Warning dialog box to 
remove the rest pages on the feeder. 

2. Click OK to close the Warning dialog box. 

3. Scan the rest pages. 
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Clear the Multi-Fed Paper: 

Choice:  Manual, Auto 

 

ansport of the multi-fed paper.  If manual is selected, once 
ulti-feed is detected and scanning operation is stopped, you 

r.  
Note:  The availability of this option varies based on type of 

 

 
If Auto is selected, once multi-feed is detected and scanning
operation is stopped, the scanner will automatically clear the 
tr
m
need to manually clear the transport of the multi-fed pape

scanner. 
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 Multi-Feed Alarm  

If a wave file is added, the scanner will make a sound 

r 

, 

Action: 

1. If “Stop Scanning after Multi-Feed” is selected, follow 
the action described in the preceding section “Stop 
Scanning after Multi-Feed” on the previous page to 
complete your job. 

2. If “Stop Scanning after Multi-Feed” has not been 
selected, rescan the pages where multi-feed is 
detected. 

 

How to add the sound alarm： 

1.  Click the Browse button on the right side of the speaker 
icon. The Open dialog box appears.  

2.  Choose your wave file.  

.  Click the Open button.  The wave file is added.  
 

Units 

Defines the primary measurement system.  Inches, 

Millimeters, and Pixels are available.  
 

 

alarm if multi-feed is detected yet no Warning dialog box 
will be displayed.   

If “Stop Scanning after Multi-Feed” is selected, the scanne
will stop the feeder.   

If “Stop Scanning after Multi-Feed” has not been selected
the scanner will continue to scan till the end of your 
document. 

3
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4.5.3 Relative to Document 

 
Rela
docu

This
documents and deliver these images in B&W, Gray, or Color 
separately.  For example, there are applications which require 
you
docu r 
documents where a photograph, or signature appears in a 

ea on the document such as resumes, and so on.   

or.   

ive to Document” or “Fixed 

2. Cho The 
sele e will be displayed in a red rectangular 
box.  This is also the scan size of your entire document. 
(For example, ISO B5.  If you have not chosen a scan area 

e, then the default area will 

 

tive to Document: (used for batches of same-sized 
ments) 

 option allows you to crop different areas on your 

 to store the entire document in B&W and a part of the 
ment in color to save storage space.  This is useful fo

consistent ar
 
The following procedure describes how to reproduce the entire 
document in B&W and a portion of document (picture) in col
 
1. On the Paper tab, choose “Relat

to Transport” from the Cropping option. 

ose your scan size from the Scan Area option.  
cted scan siz

and leave the selection as Non
be the scanner’s maximum.)  

 

1 

A red 
rectangular 
box 

2 
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3. Click the Preview tab to disp

black rectangular box appea
lay the Preview window.  A 
rs to indicate the max. scan 

size your have just selected. 

The Image The selected 
ge  Selection 

Box 
ima

A black 
rectang
box 

ular 

 
 
4. Click the Preview button to view the entire image in low 

resolution to correctly crop your relative scan area.  

 

The Preview 
Image 

The Preview 
Button 

5. Select image type from the Image Selection box e 
selected image will appear in highlighted color. (For 
example, Front Color) 

6. Place your cursor on the Preview window and click your 
left mouse button.  A cross sign will appear as illustrated.  
Create your relative scan size diagonally by dragging the 
left mouse button to your preferable size.  The selected 
area will appear in a red box as illustrated.  

.  Th

 4-38



User’s Manual 

 
 

 
 
 

 
 
 
 
 
 

7. Check the B&W image from the Image Selection box to 
scan the entire document. 

8. Click the Scan button to start scanning the document in 
two image types and sizes.  (See the result in below.)  

 

 
 
 

A Cross 
The 

a  

Sign 
Relative 
Are

   
   The entire document in B&W     The relative area in color 
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4.6 e Preview Tab 

 
The P eview tab allows you to preview (a low-resolution 
your image before final scan.  This preview image lets yo
allocate your scan area.  You can choose your scan area by the 
“Scan Area” drop down list box or placing your cursor on the 
Display window and dragging it diagonally on the Display 
window.  Then, a red rectangle box will appear to indicate the 
selected area. 

”, 
review tab is not allowed. 

Th

r scan) 
u 

 
Note:  If you choose “Automatic Cropping” on the “Paper Tab
then to select a scan area on the P
 

 

The Display 
Window 

 
The Preview Tab 
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4.7 The Options Tab 

u to set following additional image 
processing settings.   
The Options tab allows yo

 

 

The Option tab dialog box 
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This is applied to double-sided 
document which are viewed in 
portrait are sometime fed into the 
scanner in landscape or vice versa.   

Choice: Book, Fanfold. 

If “Book” is selected, the image of 
the reverse side will not be rotated.  

 
The following illustration shows the documents which should 
be viewed in portrait are fed into the scanner in landscape 
 

 
 

Flip Side 
Rotation 

Select “fanfold” to rotate the image 
of the reverse side to 180 degrees.   
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Rotate Image 

ise), 

Choose the rotation angle from the 
drop down list if you wish to rotate 
your scanned image. 

Choice: None, 90°CW(clockw
90°CCW(counter clockwise), 
180°. 

 

 

Original  
Rotate 90°CW 

 
Rotate 
90°CCW 

 

 

Rotate 180° 

 
 

Blank Page 
Removal 

Check if you wish to remove the 
blank page and move the slider to 
the left or right to your desired 
threshold.   
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Edge 
Fill 

ult 

Ch

En
value is 0.

eck White or Black if you wish to add white or 
black edge on the border of your scanned 
image. ter the value from 0 to 5 mm.  Defa

 

 
Original 

 
Edge Fill: 5mm (Black) 

 
Image 
Control 
Option 

Check the Mirror box if you wish to reverse the 
right and left side of your image. 

 
Original 

 
The Mirror Effect  
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B und
S g 

ound. 
 

(auto docum

available.   
 

ackgro
ettin

 This option allows you to set your scan 
background. 
Choice: White Background, Black 
Backgr

*This option varies based on type of scanner 
and is available for the front page in the ADF 

ent feeder) only.  For the rear 
page, only the white background is 

 
White Background 

 

 
Black Background  
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4.8 The Setti

The Setting tab

 

ng Tab  

 allows you to set the following settings: 

 

The Setting tab dialog box 
 
Energy Saving Check the Enable Energy Saver box 
Control and move the slider to the right to set 

the amount of time to start the energy 
saver after your last action. The range 
is from 1 to 240 minutes.  The default 
is 15 minutes. 
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Setting 
 Sca  

To increase the scanning speed, the 

document and then sends these scanning 
data to the application.  Therefore, during 
scanning, the numbers of pages been 
scanned on the scanner is somehow 
different with the numbers of pages 
displayed on your computer screen.  
Choose this mode if you wish to complete 
your scanning task at the fastest speed. 
 
•Page Scan 
If you choose Page Scan, during scanning, 
the scanner will first scan only one page of 
your document and then send the scanned 
data to the application and then scan the 
next page and send the next data to the 
application, and so on.   Therefore, in this 
mode, the scanning speed is slower yet this 
helps to keep the same scanning progress 
between the scanner and your computer 
screen. 

 

Batch Scan •Batch n

 scanner first scans a few pages of your 

Barcode Check this option to enable detecting and 
Detection recognizing barcode in your document. 

After the detecting process, an 
avbarcode.ini file will be generated and 
stored in your system drive, for example, 
Windows\avbarcode.ini.  
Note:  The availability of this feature varies 
based on type of scanner. 
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Show Scann
Progress

in
 

 the scanning progress bar g Check and
will be shown during scanning. 

Show Warning Check to show the warning messages 
such as “ADF pad count exceeds 
50,000 scans (the number varies b

Message 
ased 

on type of scanner). Please replace the 
ADF pad and reset the pad count.” 

Save Settings
after Closing  

Next time when you open the Scanner 
 dialog box, the previously 

 Check to save your scanner properties 
settings after leaving the dialog box. 

Properties
saved settings will be shown. 
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4 i

The Information tab displays th
i

.9 The Informat on Tab  

e following system and scanner 
nformation.  

 
 

The Information tab dialog box 
 
 

The “Report” button： 

If you encounter any error message while using the scanner, 
click the Report button.  A report.txt file (C:\AVxxx) will be 
generated.  Please send this file to the nearest service center 
for trouble shooting.   
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ton」： 

ence 
problems with document feeding.  In this case, it is highly 
recommended to replace the ADF pad with a new one. (Please 
refer to the manual for proper replacing procedure.)  For 
ordering the ADF pad, please consult your nearest dealer.  
After replacing the ADF pad, click the “Reset Pad Count” 
button to reset the pad count.  

 

The “Reset Roller Count” button」： 

After scanning approximately 200,000 pages (the number 
varies based on type of scanner) through the ADF, the ADF 
roller may be worn out and you may experience problems with 
document feeding.  In this case, it is highly recommended to 
replace the ADF roller with a new one. (Note the replacement 
of the ADF roller has to be performed only by authorized 
service center.  Therefore, please return your scanner for roller 
replacement.)   After replacing the ADF roller, click the “Reset 
Roller Count” button to reset the roller count.   

The “Reset Pad Count” but

After scanning approximately 50,000 pages (the number varies 
based on type of scanner) through the Auto Document Feeder 
(ADF), the ADF pad may be worn out and you may experi

Note： 
The lifetime and the replacing procedure vary based on type of 
scanner.  Please consult your nearest dealer for more details.   
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. ISIS Interface Operation 

ed 

5
 
 
 
The ISIS driver operation method is similar to the TWAIN’s. 
Every function on the ISIS interface screen is briefly describ
as below: 
 

 
 
 
Mode: Select one of scan modes, including B&W, gray, co
options. 

Dither: 5 halftone levels available, can be disabled. 

lor 

Dots per inch: Select your desired resolution. 

Contrast: Adjust the range between the darkest and the 
lightest shades in the image. 

Default: Click to reset all settings. 

Area: Select your desired scan area or position. 

Paper Size: Select your desired paper size. 

Brightness: Adjust your scan image brightness or darkness. 
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6. aintenance M
 
 

The scanner is designed to be maintenance free.  However, 
it still needs to be cleaned occasionally to ensure optimum 
image quality and performance. 
 
From time to time the pad assembly and feeding rollers 
may become contaminated with ink, toner particles or 
paper dust.  In this case the scanner may not feed 
documents smoothly or several documents may feed at 
once.  If this occurs please follow the cleaning procedures 
to return your scanner to its original state.  

 

the feeding 
de.  Rotate 

 repeat the 

ction from top to bottom.  Be 

6.1 Cleaning the ADF  

The cleaning procedures  

 

1. Moisten a cotton swab with isoprophyl alcohol (95%).   

2. Carefully open the ADF to the left.  Wipe 
rollers by moving the swab from side to si
the rollers forward with your finger and
above cleaning procedures until the rollers are clean.  
Be careful not to snag or damage the pick springs. 

3. Wipe the pad in the dire
careful not to hook the pick springs. 

4. Close the ADF unit.  Your scanner is now ready for 
use. 
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6.2 C aning the Glass le

he procedures: 

1. Soak a cotton swab with some isoprophy alcohol 
(

2. Open the ADF unit and document cover as shown in 

3 ment cover.  Your 
scanner is now ready for use. 

 

 

T

95%). 

Figure 6-2.  Wipe the glass of flatbed area and ADF 
area by moving the swab from side to side. 

. Close the ADF unit and docu

Glass 

 
 

Figure 6-2  The Cleaning Area 
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6.3 Replacing the ADF snap-in pad module 

 
After scanning approximately 20,000 pages through the 
ADF, the separation pad may be worn out and you may 
experience problems with document feeding.  In this case, it 
is highly recommended to replace the pad mod
new one.  For ordering the pad module, please consult your 

ealer and follow the procedure below to replace it.  

Disassembling Procedure 
 
1. Open the ADF cover. 

2. Remove the ADF snap-in pad module by pulling out 
the upper part of the pad clamp as shown in Figure 6-
3. 

 

 

 

ule with a 

nearest d
 

 
 

 
 

Figure 6-3 Remove the ADF Pad 
 

ADF Pad 
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1. Take out the ADF pad module from the box. 

e pad clamp and place it 

 
Assembling Procedure 

 

2. Hold the upper part of th
gently to the pad holder as shown in Figure 6-4. 

 
 
 

      
 

Figure 6-4 Install the ADF Pad 
 
 

ADF Pad 
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.4 Replacing the ADF Paper Feed Roller 6  

 
 
1. Open the ADF cover. 
 

 

ADF cover 

 
 
2. Lift the tabs. 
 

 

Tab 
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Remove the paper feed roller cover. 3. 

 

 

ADF roller 
cover 

 

 
4. Remove the paper feed roller. 
 

 

ADF paper 
feed roller 
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5. Insert the new paper feed roller by aligning the tabs 
ace. 

 

into the slots and pressing the roller into pl
 

 

Slot 

 

 
6. Reinsert the paper feed roller cover and snap it into 

place. 
 

 
 

7.  Close the ADF cover. 

 



User’s Manual 

7. Trouble shooting 

 

The scanner will automatically perform a simple self-test 

each time it is turned on.  This will help spot major system 

errors in the scanner itself. 

When the test is initiated, the READY LED is flashing.  When 

the test is completed, if no error occurs, the READY LED is 

steadily on. 

If you have problems with th oper tion of your scanner, 

please check the following o bleshooting hints.  

.1 Question and Answer 

Question:  The LED indicates that the scanner is ready, 
but the scanner does not respond to the 
scan command from the host computer. 

Answer:  a) Please check if the signal cable is firmly 
seated, and invoke the scan command 
again.  If there is still no response, please 
reset the scanner by turning it off and then 
on again, and reboot your host computer as 
well. 

  b) Check if the driver is correctly installed.   

 

e a

tr u

 

7
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Answer: a) Open the ADF unit. 
b) Pull out the jammed paper carefully. 

  c) Close the ADF unit. 

 

 

Question:  More than one sheet of paper were fed into 

the scanner. 

Answer: a) Open ADF unit. 

  b) Remove the multi-fed sheets of paper. 

  c) Close the ADF unit. 

  d) Flatten the corners and edges; loosen 
the paper before reloading it in the paper 

e)  Check the feeding roller condition and 
do the cleaning if necessary.  

Question:  Paper becomes skewed in the scanner. 

Answer: a) Check the feeding roller condition; do the 
cleaning if necessary.  

  b) Use the paper guide when feeding the 
paper. 

Question:  Paper becomes jammed during scanning.

guide. 
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Question:  When I power on the scanner, it makes 

noises and will not stand ready. 

Answer: There are two possibilities: 

h 

iner first. 

  b) You did not place the scanner on a flat 

Question:  When I power on the scanner, the lamp 

  a) The lamp is out of order.  In that case, 
uthorized local dealer to 
p.  The life time of the lamp 

is about 5000 hours.  

  a) You forgot to remove the shipping switc
from the scanner.  Please remove the 
shipping reta

desktop surface.  This may cause the 
scanner to function improperly. 

 

does not light. 

Answer: The possibilities are as follows: 

contact your a
change the lam

b)  Check whether the power LED on ADF 
cover steadily lights or not. 

If it flashes, the power adapter malfunctions 
or the main board is short-circuited.   

Contact your authorized local dealer to 
replace the power adapter or main board. 
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ays comes out to be 

Answer: n to modify the 
Gamma setting to 2.2 and 1.8 for your 
printer and monitor respectively. 

face to get a brighter image. 

well otherwise, but for 

ginal. 

Answer:  Use the Brightness or Threshold setting to 

 

Question:  The scanned image alw

too dark. 

 a) Use your applicatio

b)  Use Brightness setting from the TWAIN 
user inter

 
Question:  The scanner works 

the line art, the lines scanned seem much 
thicker than those of the ori

adjust the line art image.  
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7.2 

In the event of paper jam, please follow the procedures 

below. 

i). Open the 

ii). Pull the paper out of the ADF uni

 

Paper Jam in the ADF 

ADF cover as shown in Figure 7-1. 

t carefully. 

ADF Unit 

 
 

 

 

ent Docum

 

Figure 7-1  ADF Paper Jam - Removing the Paper 
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8. Technical Service 

 

on 
l Assistance Center (ATAC).  Before contact with 

ATAC, please prepare the following information. 

S he 
bottom 
of the scanner) 

• Hardware configuration (e.g., your host CPU type, RAM 
size, free disk space, display card, interface card, etc.) 

• The name and version of your software application 
• The version of your scanner driver.  

Please call us at: 

 

 
Technical support for Avision scanner is provided at Avisi
Technica

 
• canner serial & revision number (located on t

US and Canada Area:    Avision Labs., Inc. 
 

ddress: 6815 Mowry Ave. Newark CA 94560, USA 
elephone: +1 (510) 739-2369 

Fax number: +1 (510) 739-6060 
Web Site: http://www.avision.com 
E-mail: support@avision-labs.com 

A
T

Other Area:    Avision Inc. 
 
Address: No.20, Creation Road I, Hsinchu Science 

Park, Taiwan, R.O.C. 
Telephone: +886 (3) 578-2388 
Fax number: +886 (3) 577-7017 
Web Site: http://www.avision.com 
Email: service@avision.com.tw 
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9. pecifications 

canning Mode B&W 

Color  

0 x 600 dpi  

ght

Scan Area Flatbed: up to European A4  

(8.5” x 11.69”) 

ADF: 3.7” x 5.5”(Min) 

tion ing) 

Operation 10°C to 35°C 

imension 567 x 350 x 199 mm 

S
 
 
 
Model Number DF-0902H 

S
Gray  

Optical 60
Resolution 

 Source Cold Cathode fluorescent lamp Li

ADF Capacity 50 sheets 

ADF: 8.5” x 14”(Max) 

Interface USB 2.0 

Power 
Requirement 

24Vdc, 2.0A 

Power 
Consump

< 48 watts (operation) 

<   7 watts (power sav

Temperature 

D

Weight 7.2 kg (15.87 lbs)  
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Index 

Ａ 
A ete

ADF cover, 7-5 
ADF Scanning, 3-2 

Ｂ 
B
Background Level, 4
Background Setting, 4-
balance wire, 3-2 
Barcode, 4-44 
Binarization 

Dynamic Threshold, 
ng, 4-8 

Blank Page Removal
Brightness  

Ｃ 
C Glass, 6-3
C
C

, Remov
e Blue, 4-2

Color Match, 4-14 
Contrast, 4-10 
Cropping 

Automatic, Fix to Transport, 
EOP Detection, 4-25 

Ｄ 
default settings, 4-3 
Deskew, 4-28 
document cover, 2-5 
Document Loading, 3-1 

Ｅ 

Energy Saving, 4-43 

Ｆ 
reshold, 4-22 
 Rotation, 4-39 

Ｇ 

Ｉ 
4-12 

Ｊ 
JPEG, 4-19 

Ｍ 
Mirror, 4-41 
Multi-Feed Detection, 4-29 

 
 

dditional Length D ction, 4-
29 

&W, 4-6 
-22 
42 

Fixed Flip Side
Processi

,  4-40
, 4-10

leaning the 
olor, 4-6 
olor Dropout 

 

Remove Red e Green, 
Invert, 

Edge Fill, 4-41 

Filter Th

G4, 4-19 
Gray, 4-6 

1 Remov

 a



 

 b

Ｏ 
output paper tray, 2-6 
output paper tray extension, 2-

6 
OverScan, 4-29 

Ｐ 
paper jam, 3-2, 7-5 
protrusions, 2-6 

Ｒ 
reference mark, 3-1 
refit the shipping bracket, 2-4 

Reset Pad Count, 4-47 
Reset Roller Count, 4-47 
Resolution, 4-11 
Rotate Image, 4-40 

Ｓ 
Scan Area, 4-28 

Ｕ 
Ultrasonic Detection, 4-31 

 


	1. Introduction
	2. Installation
	2.1 Unlocking the Shipping switch
	2.1.1 Unlocking the scanner
	2.1.2 Locking the Shipping switch

	2.2 ADF Paper Chute
	2.3 ADF Output Tray 
	2.4 Connecting the Cables
	2.4.1 Connecting to Power

	2.5 Installing the Software
	2.6 Connecting to Computer

	3. Completing Your First Scan
	3.1 Document Loading
	3.2 ADF Scanning
	3.3 Verifying Your Scanner Installation  
	3.3.1 A Glance of the Scanner Properties Dialog Box


	4. Using the Scanner Properties Dialog Box 
	4.1 Buttons on the Scanner Properties Dialog Box 
	4.2 The Image Tab 
	4.2.1 The Image Selection Box
	4.2.2 Other Image Options
	4.2.3 Scanning color images
	4.2.4 Scanning grayscale images 
	4.2.5 Scanning B&W images 
	4.2.6 Editing Profiles

	4.3 The Compression Tab
	4.4 The Color Dropout Tab  
	4.4.1 Color Dropout Selection
	4.4.2 Other Color Dropout Options

	4.5 The Paper Tab 
	4.5.1 Cropping 
	4.5.2 Other Paper Selection
	4.5.3 Relative to Document

	4.6 The Preview Tab
	4.7 The Options Tab
	4.8 The Setting Tab 
	4.9 The Information Tab 

	5. ISIS Interface Operation
	6. Maintenance
	6.1 Cleaning the ADF 
	6.2 Cleaning the Glass
	6.3 Replacing the ADF snap-in pad module
	6.4 Replacing the ADF Paper Feed Roller

	7. Trouble shooting
	7.1 Question and Answer
	7.2 Paper Jam in the ADF

	8. Technical Service
	9. Specifications
	Index



